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Conventions used in this guide
TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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1 Product basics

● Product comparison

● Serial number and model number location

● Control-panel layout

ENWW 1



Product comparison
Model Features

HP LaserJet Enterprise 500 color
M551n

Part number: CF081A

Performance
● Prints up to 33 pages per minute (ppm) on Letter size paper and 32 ppm on A4

size paper

Paper handling
● 100-sheet multipurpose input tray (Tray 1)

● 500-sheet input tray (Tray 2)

● 250-sheet, face-down output bin

Supported operating systems
● Windows® XP (32-bit and 64-bit)

● Windows Vista® (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

● Windows Server 2008 (32-bit and 64-bit) R2 64-bit

● Mac OS X v10.5 and v10.6

Connectivity
● Hi-speed USB 2.0 port

● HP Jetdirect embedded print server for connecting to a 10/100Base-TX network

● Wireless accessory available

Memory
● 1 gigabyte (GB) of random access memory (RAM)

Control-panel display
● 4-line color
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Model Features

HP LaserJet Enterprise 500 color
M551dn

Part number: CF082A

This model has the same features as HP LaserJet Enterprise 500 color M551n plus the
following:

Paper handling
● Automatic two-sided printing

Connectivity
● Hardware integration pocket for adding solutions

● USB port on the control panel for walk-up printing

HP LaserJet Enterprise 500 color
M551xh

Part number: CF083A

This model has the same features as HP LaserJet Enterprise 500 color M551dn plus the
following:

Paper handling
● 500-sheet paper and heavy media tray (Tray 3)

Memory
● HP Encrypted High Performance Hard Disk (250 GB)
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Serial number and model number location
The model number and serial number are listed on an identification label located on the back of the
product. The serial number contains information about the country/region of origin, the product
version, production code, and the production number of the product.

4 Chapter 1   Product basics ENWW



Control-panel layout
The control panel includes a color, graphical and text display, job-control buttons, and three light-
emitting diode (LED) status lights. 

1 2 3 4

5

7

6

89

11

10

1 Control panel display Shows status information, menus, help information, and error messages.

2 Up arrow button Navigates menus and text, and increases the values of numerical items in
the display.

3 OK button Makes selections, resumes printing after continuable errors, and overrides
a non-HP print cartridge.

4 Ready light The Ready light indicates that the product is ready to begin processing any
job.

5 Data light The Data light indicates that the product is receiving data.

6 Attention light The Attention light indicates that the product has a condition that requires
intervention. Examples include an empty paper tray or an error message
on the display.

7 Down arrow button Navigates menus and text, and decreases the values of numerical items in
the display.

8 Home  button Opens and closes menus.

9 Back arrow  button Navigates backward in nested menus.

10 Stop  button Halts the current job, presents a choice to resume or cancel the current job,
clears paper from the product, and clears any continuable errors that are
associated with the halted job. If the product is not printing a job, pressing
the Stop  button pauses the product.

11 Help  button Provides detailed information, including animations, about product
messages or menus.
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Control-panel help
The product has a built-in Help system that explains how to use each screen. To open the Help system,
press the Help  button on the control panel.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by pressing the arrow buttons on the control panel.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.
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2 Control panel menus

● Control panel menus

● Sign In menu

● Retrieve Job From USB menu

● Retrieve Job From Device Memory menu

● Supplies menu

● Trays menu

● Administration menu

● Troubleshooting menu

● Device Maintenance menu
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Control panel menus
To use all of the capabilities of this product, a firmware upgrade might be required. HP recommends
that you periodically go to www.hp.com/go/lj500colorM551_software to see if a new version of
firmware is available.

NOTE: Print a configuration page to determine the version of firmware currently installed in this
product.

Navigate the control-panel menus
● Press the Home  button to access the menus.

● Use the up arrow button  and down arrow button  to highlight a desired menu item.

● Press the OK button to select the menu item.

Sign In menu

Table 2-1  Sign In menu

First level Second level Values

User Access Code Access Code  

Administrator Access Code Access Code  

Service Access Code Access Code  

Retrieve Job From USB menu
Use the Retrieve Job From USB menu to view listings of jobs stored on an external USB memory
device.

NOTE: You must enable this feature by using the control-panel menus or the HP Embedded Web
Server before it can be used.

To enable this feature by using the control-panel menus, access the Administration menu, Retrieve
From USB Settings sub menu, and then select Enable. To enable this feature by using the HP
Embedded Web Server, access the Print tab.

Table 2-2  Retrieve Job From USB menu

First level Second level Values

Retrieve Job From USB  OK

Cancel

 Select a File or Folder Select from the provided list.
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Retrieve Job From Device Memory menu
Use the Retrieve Job From Device Memory menu to view listings of jobs stored on the internal
product memory.

Table 2-3  Retrieve Job From Device Memory menu

First level Second level Third level Fourth level Fifth level Values

Retrieve Job From
Device Memory

NOTE: Select from a
list of folders.

All Jobs (With PIN)

NOTE: Individual job
names also appear.

Print Enter Pin to
Print

 

 Copies Range: 1 – 9999

Default = 1

Print and Delete Enter Pin to
Print

 

 Copies Range: 1 – 9999

Default = 1

Delete Enter Pin to
Print

 

All Jobs (No PIN)

NOTE: Individual job
names also appear.

Print Copies Range: 1 – 9999

Default = 1

Print and Delete Copies Range: 1 – 9999

Default = 1

Delete Delete All Jobs Yes

No
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Supplies menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-4  Supplies menu

First level Second level Third level Fourth level Values  

Manage Supplies Print Supplies
Status

    

 Supply Settings Black Cartridge Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

 1-100%

  Color Cartridges Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

Cyan Cartridge

Magenta
Cartridge

Yellow Cartridge

1-100%

  Toner Collection
Unit

Very Low
Settings

 Stop*

Prompt to
continue

Continue

  Transfer Kit Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

 1-100%

  Fuser Kit Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

 1-100%
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Table 2-4  Supplies menu (continued)

First level Second level Third level Fourth level Values  

  Color/Black Mix   Auto*

Mostly Color
Pages

Mostly Black
Pages

 Supply Messages Low Message   On*

Off

  Level Gauge   On*

Off
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Trays menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-5  Trays menu

First level Second level Values

Manage Trays Use Requested Tray Exclusively*

First

 Manually Feed Prompt Always*

Unless loaded

 Size/Type Prompt Display*

Do not display

 Use Another Tray Enabled*

Disabled

 Alternative Letterhead Mode Disabled*

Enabled

 Blank Pages Auto*

Yes

 Override A4/Letter Yes*

No

Tray 1 Size  Select from a provided list.

Tray 1 Type  Select from a provided list.

Tray 2 Size  Select from a provided list.

Tray 2 Type  Select from a provided list.

Tray 3 Size  Select from a provided list.

Tray 3 Type  Select from a provided list.
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Administration menu
Reports menu
Table 2-6  Reports menu

First level Second level Third level Values

Configuration/Status Pages Print   

 Menu Map   

 Configuration Pages   

 Supplies Status   

 Usage Page   

 Paper Path Page   

 File Directory Page   

 Current Settings Page   

 Color Usage   

Other Pages Print   

 Demo Page   

 Print RGB Samples   

 CMYK Samples   

 PCL Font List   

 PS Font List   

General Settings menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-7  General Settings menu

First level Second level Third level Fourth level Values

Date/Time Settings Date/Time Format Date Format  DD/MMM/YYYY

MMM/DD/YYYY*

YYYY/MMM/DD

  Time Format  12 hour (AM/PM)*

24 hours

 Date/Time Date   

  Time   

  Time Zone   
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Adjust for Daylight
Savings

 On

Off*

Energy Settings Sleep Schedule A list of scheduled events
displays.

  

  + (Add)

Edit

Edit

Delete

 

   Event Type Wake Up

Sleep

   Event Time  

   Event Days Select days of the week.

 Sleep Delay   The default value is 45
minutes.

Enter a value between 1
and 120 minutes.

 Optimum Speed/
Energy Usage

  Faster First Page*

Save Energy

Save More Energy

Save Most Energy

Print Quality Adjust Color Highlights Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

Default = 0

  Midtones Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

Default = 0

  Shadows Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

Default = 0

  Restore Color Values   

 Image Registration Adjust Tray <X> Print Test Page  
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

   X1 Shift

Y1 Shift

X2 Shift

Y2 Shift

-5.00 mm to 5.00 mm

Default = 0

 Auto Sense Behavior Tray 1 Sensing  Full sensing

Transparency only

 Adjust Paper Types Select from a list of paper
types that the product
supports. The available
options are the same for
each paper type.

Print Mode Select from a list of print
modes.

Default = Auto Sense
Behavior

   Resistance Mode Normal*

Up

Down

   Humidity Mode Normal*

High

   Pre-Rotation Mode Off

On

   Fuser Temp Mode Normal*

Up

Down

   Paper Curl Mode Normal*

Reduced

 Optimize Normal Paper  Standard*

Smooth

  Light Media  Normal*

Alternate

  Heavy Paper  Standard*

Smooth

  Envelope Control  Normal*

Alternate 1

Alternate 2
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Environment  Normal*

Low Temp

  Line Voltage  Normal*

Low Voltage

  Tray 1  Normal*

Alternate

  Cleaning Control  Normal*

Alternate

  Background  Normal*

Alternate 1

Alternate 2

Alternate 3

  Media Temp  Normal*

Alternate

  Uniformity Control  Normal*

Alternate 1

Alternate 2

Alternate 3

  Pre-rotation  Normal*

Alternate 1

Alternate 2

Alternate 3

  Registration  Normal*

Alternate

  Transfer Control  Normal*

Alternate 1

Alternate 2

Alternate 3

  Moisture Control  Normal*

Alternate

  Restore Optimize   
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

 Edge Control   Off

Light

Normal*

Maximum

Jam Recovery    Auto*

Off

On

Auto Recovery    Enable

Disable

RAM Disk    Auto

Off

Manage Stored Jobs Quick Copy Job
Storage Limit

  1-300

Default = 32

 Quick Copy Job Held
Timeout

  Off*

1 Hour

4 Hours

1 Day

1 Week

 Default Folder Name    

 Sort Stored Jobs By   Job Name*

Date

Restore Factory
Settings

Reset   All

General

Print

General Security

Calibration

Restrict Color    Enable color

Disable color

Color if allowed*
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Retrieve From USB Settings menu
Table 2-8  Retrieve From USB Settings menu

First level Second level Values

Retrieve From USB Settings  Enable

Disable*

Print Settings menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-9  Print Settings menu

First level Second level Values

Manual Feed  Enabled

Disabled*

Courier Font  Regular*

Dark

Wide A4  Enabled

Disabled*

Print PS Errors  Enabled

Disabled*

Print PDF Errors  Enabled

Disabled*

Personality  Auto*

PCL

PS

PDF

PCL Form Length Range: 5 – 128

Default = 60

 Orientation Portrait*

Landscape

 Font Source Internal*

Soft

USB <X>
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Table 2-9  Print Settings menu (continued)

First level Second level Values

 Font Number Range: 0 – 999

Default = 0

 Font Pitch Range: 0.44 – 99.99

Default = 10

 Font Point Size Range: 4.00 – 999.75

Default = 12.00

 Symbol Set Select from a list of symbol sets.

 Append CR to LF No*

Yes

 Suppress Blank Pages No*

Yes

 Media Source Mapping Standard*

Classic

Print Options menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-10  Print Options menu

First level Second level   Values

Number of Copies    Range: 1 – X

Default = 1

Default Paper Size    Select from a list of sizes
that the product supports.

Default Custom Paper
Size

Unit of Measure Inches X Dimension Range: 2.99 – 12.28

Default = 12.28

   Y Dimension Range: 5.00 – 18.50

Default = 18.5

  MM X Dimension Range: 76 – 312

Default = 312

   Y Dimension Range: 127 – 470

Default = 470
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Table 2-10  Print Options menu (continued)

First level Second level   Values

Sides    1-sided*

2-sided

Two-Sided Format    Book-style*

Flip-style

Edge to Edge
Overrides

   Enabled

Disabled*
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Display Settings menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-11  Display Settings menu

First level Second level Values

Display Brightness  Range: -10 to 10

Default = 0

Language  Select from a list of languages that the
product supports.

Show IP Address  Display*

Hide

Sleep Mode  Disabled

Use sleep delay*

Use sleep schedule

Use both

Inactivity Timeout  Range: 10 – 300 seconds

Default = 60

Clearable Warnings  On

Job*

Continuable Events  Auto continue (10 seconds)*

Press OK to continue
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Manage Supplies menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-12  Manage Supplies menu

First level Second level Third level Fourth level Values

Print Supplies Status     

Supply Settings Black Cartridge Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

 1-100%

 Color Cartridges Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

Cyan Cartridge

Magenta Cartridge

Yellow Cartridge

1-100%

 Toner Collection Unit Very Low Settings  Stop*

Prompt to continue

Continue

 Transfer Kit Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

 1-100%

 Fuser Kit Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

 1-100%

 Color/Black Mix   Auto*

Mostly Color Pages

Mostly Black Pages

Supply Messages Low Message   On*

Off
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Table 2-12  Manage Supplies menu (continued)

First level Second level Third level Fourth level Values

 Level Gauge   On*

Off

Reset Supplies New Fuser Kit   No

Yes

 New Transfer Kit   No

Yes

Manage Trays menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-13  Manage Trays menu

First level Values

Use Requested Tray Exclusively*

First

Manually Feed Prompt Always*

Unless loaded

Size/Type Prompt Display*

Do not display

Use Another Tray Enabled*

Disabled

Alternative Letterhead Mode Disabled*

Enabled

Blank Pages Auto*

Yes

Override A4/Letter Yes*

No
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Network Settings menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-14  Network Settings menu

First level Values

I/O Timeout Range: 5 – 300 sec

Default = 15

Embedded Jetdirect See the table that follows for details. These menus have the same
structure. If an additional HP Jetdirect network card is installed in the
EIO slot, then both menus are available.

Table 2-15  Embedded Jetdirect

First level Second level Third level Fourth level Fifth level Values

Information Print Sec Report    Yes

No*

TCP/IP Enable    On*

Off

 Host Name    Use the arrow
buttons to edit the
host name.

NPIXXXXXX*

 IPv4 Settings Config Method   Bootp*

DHCP

Auto IP

Manual

  Default IP   Auto IP*

Legacy

  DHCP Release   Yes

No*

  DHCP Renew   Yes

No*

  Primary DNS   Range: 0 – 255

Default =
xxx.xxx.xx.xx

  Secondary DNS   Range: 0 – 255

Default = 0.0.0.0
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Table 2-15  Embedded Jetdirect (continued)

First level Second level Third level Fourth level Fifth level Values

 IPv6 Settings Enable   On*

Off

  Address Manual Settings Enable On

Off*

    Address Select from a
provided list.

  DHCPV6 Policy   Router Specified

Router
Unavailable*

Always

  Primary DNS   Select from a
provided list.

  Secondary DNS   Select from a
provided list.

 Proxy Server    Select from a
provided list.

 Proxy Port    Default = 00080

 Idle Timeout    Default = 0270

General Security Secure Web    HTTPS Required*

HTTPS Optional

 IPSEC    Keep

Disable*

 802.1x    Reset

Keep*

 Reset Security    Yes

No*

Diagnostics Embedded Tests LAN HW Test   Yes

No*

  HTTP Test   Yes

No*

  SNMP Test   Yes

No*
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Table 2-15  Embedded Jetdirect (continued)

First level Second level Third level Fourth level Fifth level Values

  Data Path Test   Yes

No*

  Select All Tests   Yes

No*

  Execution Time   Range: 1 – 60 hours

Default = 1

  Execute   Yes

No*

 Ping Test Dest Type   IPv4

IPv6

  Dest IPv4   Range: 0 – 255

Default =
127.0.0.1

  Dest IPv6   Select from a
provided list.

Default = : : 1

  Packet Size   Default = 64

  Timeout   Default = 001

  Count   Default = 004

  Print Results   Yes

No*

  Execute   Yes

No*

 Ping Results Packets Sent   Default = 00000

  Packets Received   Default = 00000

  Percent Lost   Default = 000

  RTT Min   Default = 0000

  RTT Max   Default = 0000

  RTT Average   Default = 0000

  Ping In Progress   Yes

No*
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Table 2-15  Embedded Jetdirect (continued)

First level Second level Third level Fourth level Fifth level Values

  Refresh   Yes

No*

Link Speed     Auto*

10T Half

10T Full

100TX Half

100TX Full

100TX Auto

1000T Full
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Troubleshooting menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-16  Troubleshooting menu

First level Second level Third level Fourth level Values

Exit Troubleshooting

NOTE: This item only
displays if you are
backing out of the
Troubleshooting menu.

NOTE: The product
shuts down and restarts
when this menu item is
selected.

    

Print Event Log     

View Event Log     

Print Paper Path
Page

    

Print Quality Pages Print PQ
Troubleshooting
Pages

   

 Print Diagnostic Page    

 Color Band Test Print Test Page   

  Copies  Range: 1 – 30

Default = 1

Diagnostic Tests Disable Cartridge
Check

   

 Paper Path Sensors   Start Test

 Paper Path Test Print Test Page  Print

  Source Tray  Select from a list of the
available trays.

  Test Duplex Path  Off*

On

  Number of Copies  Range: 1 – 500

Default = 1

 Manual Sensor Test   Select from a list of the
product sensors.

 Tray/Bin Manual
Sensor Test

  Select from a list of the
product sensors.
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Table 2-16  Troubleshooting menu (continued)

First level Second level Third level Fourth level Values

 Component Test   Select from a list of
available components.

  Repeat  Off*

On

 Print/Stop Test    

Retrieve Diagnostic
Data

Export to USB    

 Diagnostic Files   Device Data File

Debug Information
File*

 Include Crash Dumps   Off

On*

 Cleanup Debug Info   Off

On*

General Debug Data     
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Device Maintenance menu
Backup/Restore menu

CAUTION: Data backup and restoration is the responsibility of the customer/administrator of the
product. Service personnel should not back up or restore customer data under any circumstances.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-17  Backup/Restore menu

First level Second level Third level Values

Backup Data Scheduled Backups Enable Scheduling Disabled*

Enabled

  Backup Time Default = current time

  Days Between Backups Default = 1

 Backup Now   

 Export Last Backup   

Restore Data   Insert a USB drive that contains
the backup file.

Calibration/Cleaning menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-18  Calibration/Cleaning menu

First level Second level Values

Auto Cleaning  Off*

On

Cleaning Interval  Select from a list of cleaning intervals.

Auto Cleaning Size  Letter*

A4

Print Cleaning Page   

Clean Laser Glass   

Quick Calibration   

Full Calibration   

Delay Calibration at Wake/Power
On

 Yes*

No
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USB Firmware Upgrade menu
To display: At the product control panel, select the Device Maintenance menu, and then select the
USB Firmware Upgrade menu.

Insert a USB storage device with a firmware upgrade bundle into the USB port, and follow the on-
screen instructions.

Service menu
The Service menu is locked and requires a PIN for access. This menu is intended for use by authorized
service personnel.
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3 Connect the product

● Connect to a network
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Connect to a network
You can configure network parameters from the control panel, the HP Embedded Web Server, or for
most networks, from the HP Web Jetadmin software.

NOTE: HP Web Jetadmin software is not supported on Mac OS X operating systems.

For a complete list of supported networks and for instructions on configuring network parameters from
software, see the HP Jetdirect Embedded Print Server Administrator’s Guide. The guide comes with
products in which an HP Jetdirect embedded print server is installed.

Supported network protocols
Table 3-1  Supported network protocols

Network type Supported protocols

TCP/IP IPv4 and IPv6 networks ● Bonjour (mDNS)

● Simple Network Management Protocol (SNMP) v1, v2, and v3

● Hyper Text Transfer Protocol (HTTP)

● Secure HTTP (HTTPS)

● File Transfer Protocol (FTP)

● Port 9100

● Line printer daemon (LPD)

● Intenet Printing Protocol (IPP)

● Secure IPP

● Web Services Dynamic Discovery (WS Discovery)

● IPsec/Firewall

TCP/IP IPv4 networks only ● Auto IP

● Service Location Protocol (SLP)

● Trivial File Transfer Protocol (TFTP)

● Telnet

● Internet Group Management Protocol (IGMP) v2

● Bootstrap Protocol (BOOTP)/DHCP

● Windows Internet Name Service (WINS)

● IP Direct Mode

● WS Print
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Table 3-1  Supported network protocols (continued)

Network type Supported protocols

TCP/IP IPv6 networks only ● Dynamic Host Configuration Protocol (DHCP) v6

● Multicast Listener Discovery Protocol (MLD) v1

● Internet Control Message Protocol (ICMP) v6

Other supported network protocols ● Internetwork Packet Exchange/Sequenced Packet Exchange (IPX/SPX)

● NetWare Directory Services (NDS)

● Bindery

● Novell Distributed Print Services (NDPS)

● iPrint

Table 3-2  Advanced Security features for network management

Service name Description

IPsec/Firewall Provides network-layer security on IPv4 and IPv6 networks. A firewall provides
simple control of IP traffic. IPsec provides additional protection through
authentication and encryption protocols.

Kerberos Allows you to exchange private information across an open network by assigning a
unique key, called a ticket, to each user who logs on to the network. The ticket is
then embedded in messages to identify the sender.

SNMP v3 Employs a user-based security model for SNMP v3, which provides user
authentication and data privacy through encryption.

SSL/TLS Allows you to transmit private documents via the Internet and guarantee privacy
and data integrity between the client and server applications.

IPsec batch configuration Provides network-layer security through the simple control of IP traffic to and from
the product. This protocol provides the benefits of encryption and authentication
and allows for multiple configurations.
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Install the product on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Home  button.

4. Press the down arrow  to highlight the Administration menu, and then press the OK button.

5. Press the down arrow  to highlight the Reports menu, and then press the OK button.

6. Press the down arrow  to highlight the Configuration/Status Pages menu, and then press
the OK button.

7. Press the down arrow  to highlight the Configuration Pages item, and then press the OK
button.

8. Press the up arrow  to highlight the Print option, and then press the OK button to print the
report.
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9. Find the IP address on the Embedded Jetdirect page.

Jetdirect Page HP Color LaserJet
Page 1

10. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. See Manually configure IPv4 TCP/IP parameters from the control panel
on page 39. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address. See Manually configure IPv6 TCP/IP parameters from the
control panel on page 40.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option, and then click the
Next button.

5. From the list of available printers, select the printer that has the correct IP address.

6. Click the Finish button.

7. On the More Options screen, you can install more software, or click the Exit button.

8. Print a test page from the installer to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.
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Configure network settings

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It
has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the embedded Web server, type the IP address into the address line of a Web browser.

NOTE: For Mac OS X use the Safari browser and Bonjour to access the embedded Web server.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password

Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server, click the Security tab, and then click the General Security
link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.
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Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, syslog server, and default
gateway.

1. Press the Home  button.

2. Press the down arrow  to highlight the Administration menu, and then press the OK button.

3. Press the down arrow  to highlight the Network Settings menu, and then press the OK
button.

4. Press the down arrow  to highlight the Embedded Jetdirect menu, and then press the OK
button.

5. Press the down arrow  to highlight the TCP/IP menu, and then press the OK button.

6. Press the down arrow  to highlight the IPv4 Settings menu, and then press the OK button.

7. Press the down arrow  to highlight the Config Method menu, and then press the OK button.

8. Press the down arrow  to highlight the Manual option, and then press the OK button.

9. Press the down arrow  to highlight the Manual Settings menu, and then press the OK button.

10. Press the down arrow  to highlight the IP Address, Subnet Mask, or Default Gateway
menu, and then press the OK button.

11. Press the up arrow  or the down arrow  to increase or decrease the number for the first byte of
the IP address, subnet mask, syslog server, or default gateway.

12. Press the OK button to move to the next set of numbers, or press the back arrow  to move to the
previous set of numbers.

13. Repeat steps 10 and 11 until the IP address, subnet mask, or default gateway is complete, and
then press the OK button to save the setting.

14. Press the Home  button to return to the Ready state.
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Manually configure IPv6 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv6 address.

1. Press the Home  button.

2. Press the down arrow  to highlight the Administration menu, and then press the OK button.

3. Press the down arrow  to highlight the Network Settings menu, and then press the OK
button.

4. Press the down arrow  to highlight the Embedded Jetdirect menu, and then press the OK
button.

5. Press the down arrow  to highlight the TCP/IP menu, and then press the OK button.

6. Press the down arrow  to highlight the IPv6 Settings menu, and then press the OK button.

7. Press the down arrow  to highlight the Address menu, and then press the OK button.

8. Press the OK button to select the Manual Settings menu.

9. Press the down arrow  to highlight the Address option, and then press the OK button.

10. Press the up arrow  or the down arrow  to select the first character of the address. Press the OK
button.

Repeat this process for each character in the address.

NOTE: You must press the OK button after entering each character.

11. After entering all of the address characters, press the up arrow  or the down arrow  to select
the stop character . Press the OK button.

12. Press the Home  button to return to the Ready state.
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Link speed and duplex settings

The link speed and communication mode of the print server must match the network. For most situations,
leave the product in automatic mode. Incorrect changes to the link speed and duplex settings might
prevent the product from communicating with other network devices. If you need to make changes, use
the product control panel.

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. Press the Home  button.

2. Press the down arrow  to highlight the Administration menu, and then press the OK button.

3. Press the down arrow  to highlight the Network Settings menu, and then press the OK
button.

4. Press the down arrow  to highlight the Embedded Jetdirect menu, and then press the OK
button.

5. Press the down arrow  to highlight the Link Speed menu, and then press the OK button.

6. Press the down arrow  to highlight one of the following options.

Setting Description

Auto The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Half 10 megabytes per second (Mbps), half-duplex operation

10T Full 10 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

100TX Full 100 Mbps, full-duplex operation

100TX Auto Limits auto-negotiation to a maximum link speed of 100 Mbps

1000T Full 1000 Mbps, full-duplex operation

7. Press the OK button. The product turns off and then on.
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4 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size

● Supported paper sizes

● Supported paper types

● Load paper trays

● Configure trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause poor print quality,
increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that are
approved for use in laser printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.
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Media type Do Do not

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Change the printer driver to match the paper type
and size

NOTE: If you change the page settings in the software program, those settings override any settings
in the printer driver.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best results, select the correct paper size and type in the printer driver before
printing.

Table 4-1  Supported paper and print media sizes

Size and dimensions Tray 1 Tray 2 Tray 3 (optional)

Letter

215.9 x 279 mm (8.5 x 11 in)

Legal

215.9 x 355.6 mm (8.5 x 14 in)

 

A4

210 x 297 mm (8.27 x 11.69 in)

RA4

215 x 305 mm (8.47 x 12.01 in)

 

A5

148 x 210 mm (5.83 x 8.27 in)

B5 (JIS)

182 x 257 mm (7.17 x 10.12 in)

B6 (JIS)

128 x 182 mm (5.04 x 7.17 in)

 

Executive

184.2 x 266.7 mm (7.25 x 10.5 in)

Statement

140 x 216 mm (5.5 x 8.5 in)

 

4x6

101.6 x 152.4 mm (4 x 6 in)

 

10 x 15 cm

101.6 x 152.4 mm (4 x 6 in)

 

3x5

76.2 x 127.0 mm (3.0 x 5.0 in)

  

5x7

127 x 177.8 mm (5 x 7 in)
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Table 4-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Tray 3 (optional)

5x8

127 x 203.2 mm (5 x 8 in)

 

A6

105 x 148 mm (4.13 x 5.83 in)

 

Postcard (JIS)

100 x 148 mm (3.94 x 5.83 in)

  

Double Postcard (JIS)

148 x 200 mm (5.83 x 7.87 in)

 

16K

184 x 260 mm (7.24 x 10.24 in)

16K

195 x 270 mm (7.68 x 10.63 in)

16K

197 x 273 mm (7.8 x 10.8 in)

8.5 x 13

215.9 x 330.2 mm (8.5 x 13 in)

 

Envelope Commercial #10

104.9 x 241.3 mm (4.13 x 9.49 in)

  

Envelope #9

98.43 mm x 225.43 mm (3.88 x 8.88 in)

  

Envelope B5

176 x 250 mm (6.93 x 9.84 in)

  

Envelope C5 ISO

162 x 229 mm (6.93 x 9.84 in)

  

Envelope C6

114 x 162 mm (4.49 x 6.38 in)

  

Envelope DL ISO

110 x 220 mm (4.33 x 8.66 in)

  

Envelope Monarch

98.4 x 190.5 mm (3.88 x 7.5 in)
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Table 4-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Tray 3 (optional)

Custom

76.2 x 127 mm to 215.9 x 355.6 mm (3.0 x 5.8 in to
8.5 x 14 in)

  

Custom

101.6 x 148 mm to 215.9 x 297 mm (4.0 x 5.85 in to 8.5
x 11.69 in)

  

Custom

148 x 215.9 mm to 210 x 355.6 mm (5.83 x 8.5 in to
8.27 x 14 in)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
lj500colorM551.

Paper type Tray 1 Tray 21 Tray 3 (optional)

Plain Paper

Light 60–74 g/m2

Midweight (96–110 g/m2)

Heavy (111–130 g/m2)

Extra Heavy (131–175 g/m2)

Color Transparency

Labels

Letterhead

Preprinted

Prepunched

Colored

Rough

Bond

Recycled

Envelope   

Cardstock

Mid-weight glossy (96–110 g/m2)

Heavy glossy (111–130 g/m2)

Extra-heavy glossy (131–175 g/m2)

Card glossy (176–220 g/m2)

Opaque film

HP EcoSMART Lite Paper

HP Tough Paper

HP Matte (105 g/m2)
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Paper type Tray 1 Tray 21 Tray 3 (optional)

HP Matte (120 g/m2)

HP Matte (160 g/m2)

HP Matte (200 g/m2)

HP Soft Gloss (120 g/m2)

HP Glossy (130 g/m2)

HP Glossy (160 g/m2)

HP Glossy (220 g/m2)

1 The stack height for Tray 2 is 30 mm (1.18 in) for glossy paper and 40 mm (1.57 in) for short paper (A5, A6, 4x6, and
landscape).
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Load paper trays
Load Tray 1

1. Open Tray 1.  

2. Slide out the tray extension.  

3. Fold out the tray extension to support the
paper and set the side guides to the correct
width.

 

52 Chapter 4   Paper and print media ENWW



4. Load paper in the tray face down and the
short, top edge going into the product first.

 

5. Make sure the stack fits under the tabs on the
guides and does not exceed the load-level
indicators.

 

6. Adjust the side guides so that they lightly touch
the paper stack but do not bend it.
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Print envelopes

If your software does not automatically format an envelope, specify Landscape for page orientation in
your software program or printer driver. Use the following guidelines to set margins for return and
destination addresses on Commercial #10 or DL envelopes:

Address type Left margin Top margin

Return 15 mm (0.6 in) 15 mm (0.6 in)

Destination 102 mm (4 in) 51 mm (2 in)

For envelopes of other sizes, adjust the margin settings accordingly.

Load Tray 2
This tray holds up to 500 sheets of 75 g/m2 (20 lb) paper. If the paper is heavier, the tray does not
hold as many sheets. Do not overfill the tray.

The stack height for Tray 2 is 30 mm (1.18 in) for glossy paper and 40 mm (1.57 in) for short paper
(A5, A6, 4x6, and landscape).

CAUTION: Do not print envelopes or unsupported sizes of paper from the Tray 2. Print these types of
paper only from Tray 1.

1. Slide open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latch and
sliding the guides to the size of the paper
being used.
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3. Load paper into the tray face up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might appear during
printing or the paper might jam.

 

4. Slide the tray into the product.  

5. The control panel shows the tray’s paper type
and size. If the configuration is not correct,
follow the instructions on the control panel to
change the size or type.

 

Load the optional 500-sheet paper and heavy media tray (Tray 3)
Tray 3 holds up to 500 sheets of standard paper.

The product automatically detects the following standard sizes of paper in Tray 3: Letter, Legal,
Executive, A4, A5, and B5 (JIS).

CAUTION: Do not print envelopes or unsupported sizes of paper from Tray 3. Print these types of
paper only from Tray 1.
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Load standard-sized paper into Tray 3

1. Slide open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray face up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might appear during
printing or the paper might jam.
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4. Slide the tray into the product.  

5. The control panel shows the tray’s paper type
and size. If the configuration is not correct,
follow the instructions on the control panel to
change the size or type.

 

Load custom-size paper into Tray 3

1. Slide open the tray.  
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2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray face up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.
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4. Slide the tray into the product. The control
panel shows the paper type and size.

 

5. The control panel prompts you to set the paper
size and type. Select the Custom setting, and
then configure the X and Y dimensions of the
custom paper size.

 

NOTE: See the label in the paper tray, or the following illustration, to determine the X and Y
dimensions.

Y
X

Tray and bin capacity
To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray full indicators.
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Tray or bin Paper type Specifications Quantity

Tray 1 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 10 mm
(0.39 in)

Equivalent to 100 sheets of 75 g/m2

(20 lb) bond

Envelopes Less than 60 g/m2 (16 lb) bond to
90 g/m2 (24 lb) bond

Up to 10 envelopes

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 10 mm
(0.39 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 10 mm
(0.39 in)

Up to 50 sheets

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 10 mm (0.39
in)

Up to 50 sheets

Tray 2 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2

(59 lb) bond

Equivalent to 500 sheets of 75 g/m2

(20 lb) bond

Maximum stack height: 56 mm (2.2 in)

For A5, A6, and 4x6 paper sizes, and
for paper printed in a landscape
orientation the maximum stack height is
40 mm (1.57 in),

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 30 mm (1.18
in)

Tray 3 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2

(59 lb) bond

Equivalent to 500 sheets of 75 g/m2

(20 lb) bond

Maximum stack height: 56 mm (2.2 in)

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 56 mm (2.2 in)

Output bin Paper  Up to 300 sheets of 75 g/m2 (20 lb)
bond
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Configure trays
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or media type for a print job through the printer driver or a
software program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not appear if you are printing from Tray 1, and it is configured for the Any
Size and Any Type settings. In this situation, if the print job does not specify a tray, the product prints
from Tray 1, even if the paper size and type settings in the print job do not match the paper loaded in
Tray 1.

Configure a tray when loading paper
1. Load paper in the tray. Close the tray if you are using Tray 2 or 3.

2. The tray configuration message appears.

3. Do one of the following:

● Press the OK button to accept the size and type.

● To modify the tray size configuration, press the down arrow  to highlight the Modify
option, and then press the OK button.

a. Press the down arrow  to highlight the correct size, and then press the OK button.

b. Press the down arrow  to highlight the correct type, and then press the OK button.

Configure a tray to match print job settings
1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, the tray configuration message appears.

3. Load the tray with the specified type and size of paper, and then close the tray.

4. When the size and type confirmation messages appear, press the OK button to confirm the paper
size and type.

Configure a tray from the control panel
You can also configure the trays for type and size without a prompt from the product.

1. Press the Home  button.

2. Open the Trays menu.

3. Press the down arrow  to highlight the size or type setting for the desired tray, and then press the
OK button.
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4. Press the up arrow  or the down arrow  to highlight the size or type. If you select a custom
size, select the unit of measure, and then set the X dimension and the Y dimension.

5. Press the OK button to save your selection.

6. Press the Home  button to exit the menus.

Automatic overhead transparency sensing (auto sense mode)
The automatic media type sensor functions only when that tray is configured to the Any Type setting.
Configuring a tray to any other type, such as Bond or Glossy, deactivates the media sensor in that tray.

The product can automatically classify paper types into one of two categories:

● Non-transparency

● Transparency

For more control, a specific type must be selected in the job or configured in a tray.

Auto-sense settings

Full sensing (Tray 1 only)
● The product distinguishes between transparencies (Transparency mode) and paper (Normal

mode).

● Each time the product prints a page, it senses transparencies or non-transparencies.

● This is the slowest mode.

Transparency only
● The product distinguishes between transparencies (Transparency mode) and paper (Normal

mode).

● The product assumes that the second and all subsequent pages are of the same media type as the
first page.

● This is the fastest mode and is useful for high-volume printing in Normal mode.

Select the paper by source, type, or size
In the Microsoft Windows operating system, three settings affect how the printer driver tries to pull
media when you send a print job. Source, Type, and Size settings appear in the Page Setup, Print,
Preferences, or Print Properties dialog boxes in most software programs. Unless you change
these settings, the product automatically selects a tray using the default settings.

Source

To print by source, select a specific tray in the printer driver for the product to pull from. If you select a
tray that is configured for a type or size that does not match your print job, the product prompts you to
load the tray with the type or size of paper for your print job before printing it. When you load the
tray, the product begins printing.
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Type and size

● Printing by type or size causes the product to pull from the tray that is loaded with the correct type
and size of paper.

● Selecting paper by type rather than source helps protect special paper from accidental use.

● Using the wrong setting might result in unsatisfactory print quality. Always print by type for special
print media, such as labels or transparencies.

● Print by type or size for envelopes, if possible.

● To print by type or size, select the type or size from the Page Setup dialog box, the Print
dialog box, the Preferences dialog box, or the Print Properties dialog box, depending on
the software program.

● If you often print on a certain type or size of paper, configure a tray for that type or size. Then,
when you select that type or size as you print a job, the product automatically pulls paper from the
tray that is configured for that type or size.
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5 Print cartridges, toner collection
unit, and other supplies

● Printer sharing disclaimer

● Supplies information

● Supplies views

● Manage print cartridges

● Replacement instructions
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Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Supplies information
Color Cartridge number Part number

Standard-capacity replacement black
print cartridge

507A CE400A

High-capacity replacement black print
cartridge

507X CE400X

Replacement cyan print cartridge 507A CE401A

Replacement yellow print cartridge 507A CE402A

Replacement magenta print cartridge 507A CE403A

Environmental features: Recycle print cartridges by using the HP Planet Partners return and
recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.

The information contained herein is subject to change without notice. For the latest User Guide
information go to www.hp.com/support/lj500colorM551_manuals.

Supplies views
Print cartridge views

3

1
2

1 Plastic shield
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2 Imaging drum

3 Print cartridge memory tag
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Manage print cartridges
Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Settings for print cartridges

Print when a print cartridge is at or near end of life

● A <Color> <Supply> Low message—where <Color> is the color of the supply, and <Supply>
is the type of supply—appears when a supply is nearing the estimated end of its useful life.

● A <Color> <Supply> Very Low message appears when a supply is at its estimated end of
useful life.

Print-quality problems can occur when using a supply that is at its estimated end of life.

Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new cartridge.

CAUTION: Once an HP supply has reached Very Low, the HP premium Protection Warranty on that
supply has ended.

1. At the control panel, press the Home  button.

2. Open the following menus:

1. Administration

2. Manage Supplies

3. Supply Settings

4. Black Cartridge or Color Cartridges

5. Very Low Settings

3. Use the arrow buttons to highlight your selection, and then press the OK button to select it. Select
one of the following options:

NOTE: If you select the Stop or Prompt to continue option, the product stops printing when
it reaches the Very Low threshold. When you replace the cartridge, the product automatically
resumes printing.

● Select the Stop option to set the product to stop printing until you replace the cartridge.

● Select the Prompt to continue option to set the product to stop printing and prompt you to
replace the cartridge. You can acknowledge the prompt and continue printing.

● Select the Continue option to set the product to alert you that the cartridge is very low, but
to continue printing.

NOTE: Using the Continue setting allows printing beyond Very Low without customer
interaction and can result in unsatisfactory print quality.

68 Chapter 5   Print cartridges, toner collection unit, and other supplies ENWW



Recycle supplies
To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge
arrived. For complete information, see the recycling guide that is included with each new HP supply
item.

Print-cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.
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HP fraud Web site
Go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel
message says the cartridge is non-HP or used. HP will help determine if the cartridge is genuine and
take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP or used supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Replacement instructions
Replace print cartridges

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).

CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water.
Hot water sets toner into fabric.

NOTE: Information about recycling used print cartridges is on the print-cartridge box.

1. Open the front door. Make sure that the door
is completely open.

 

2. Grasp the handle of the used print cartridge
and pull out to remove.

 

3. Store the used print cartridge in a protective
bag. Information about recycling used print
cartridges is on the print-cartridge box.
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4. Remove the new print cartridge from its
protective bag.

 

5. Grasp both sides of the print cartridge and
distribute the toner by gently rocking the print
cartridge.

 

6. Remove the orange protective cover from the
print cartridge.

CAUTION: Avoid prolonged exposure to
light.

CAUTION: Do not touch the green roller.
Doing so can damage the cartridge.
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7. Align the print cartridge with its slot and insert
the print cartridge until it clicks into place.

 

8. Close the front door.  

Change the toner collection unit
Replace the toner collection unit when the control panel prompts you.

NOTE: The toner collection unit is designed for a single use. Do not attempt to empty the toner
collection unit and reuse it. Doing so could lead to toner being spilled inside the product, which could
result in reduced print quality. After use, return the toner collection unit to HP’s Planet Partners program
for recycling.

NOTE: If printing documents that require heavy toner coverage, the toner collection unit can fill
quickly. If printing these types of documents, HP recommends that you have another toner collection unit
available.

1. Open the front door. Make sure that the door
is completely open.
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2. Grasp the blue label at the top of the toner
collection unit and remove it from the product.

 

3. Place the attached blue cap over the blue
opening at the top of the unit.

 

4. Remove the new toner collection unit from its
packaging.

 

74 Chapter 5   Print cartridges, toner collection unit, and other supplies ENWW



5. Insert the bottom of the new unit into the
product first and then push the top of the unit
until it clicks into place.

 

6. Close the front door.

NOTE: If the toner collection unit is not
installed correctly, the front door does not
close completely.

 

To recycle the used toner collection unit, follow the instructions included with the new toner collection
unit.
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6 Print tasks

● Cancel a print job

● Basic print tasks with Windows

● Additional print tasks with Windows

● Walk-up USB printing
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Cancel a print job
1. Press the stop button  on the control panel.  

2. Press the down arrow  to highlight the
Cancel Current Job option, and then press
the OK button.

NOTE: It can take some time for all printing
to clear after you have canceled a print job.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  

Change the number of print copies with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.
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Create printing shortcuts

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

82 Chapter 6   Print tasks ENWW



4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments are
lost.

 

5. Select the print options for the new shortcut.  
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6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK
button.
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Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size, specify the dimensions, and click the OK button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper type
that you are using.

Select the paper tray with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.

Select the print resolution

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Paper/Quality tab.

4. In the Print Quality area, select the resolution from the first drop-down list.
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Print on both sides (duplex) with Windows

Manually print on both sides with Windows

NOTE: This information applies only to products that do not have an automatic duplexer.

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides (manually)
check box. Click the OK button to print the
first side of the job.

 

5. Retrieve the printed stack from the output bin,
and place it with the printed-side facing up in
Tray 1.

 

6. On the control panel, press the OK button to
print the second side of the job.

 

Automatically print on both sides with Windows

NOTE: This information applies only to products that have an automatic duplexer.
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1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the
Pages per sheet drop-down list.

 

5. Select the correct Print page borders,
Page order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.
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Set color options with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. In the Color Options area, click the Manual option, and then click the Settings button.

6. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.

94 Chapter 6   Print tasks ENWW



Additional print tasks with Windows
Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Advanced tab.

4. Expand the Document Options section.

5. Expand the Printer Features section.

6. In the Print All Text as Black drop-down list, select the Enabled option.
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Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Paper type drop-down list, click the
More... option.

 

5. Expand the list of Type is: options.  
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6. Expand the list of Other options.  

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print on special paper, labels, or transparencies

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

7. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. In the Special pages area, click the Print
pages on different paper option, and
then click the Settings button.

 

5. In the Pages in document area, select
either the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists.
Click the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.
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Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click
the Left binding or Right binding option.
The Pages per sheet option automatically
changes to 2 pages per sheet.
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Walk-up USB printing
This product features walk-up USB printing, so you can quickly print files without sending them from a
computer. The product accepts standard USB storage accessories in the USB port on the front of the
product. You can print the following types of files:

NOTE: You must enable this feature by using the control-panel menus or the HP Embedded Web
Server before it can be used.

To enable this feature by using the control-panel menus, access the Administration menu, Retrieve
From USB Settings sub menu, and then select Enable. To enable this feature by using the HP
Embedded Web Server, access the Print tab.

● .pdf

● .prn

● .pcl

● .ps

● .cht

1. Insert the USB storage accessory into the USB
port on the front of the product.

NOTE: You might need to remove the cover
from the USB port

 

2. Press the down arrow  to highlight OK, and
then press the OK button.

 

3. Press the down arrow  to highlight Select a
File or Folder, and then press the OK button.

 

4. Press the down arrow  to select a folder from
the list.
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5. Select the name of the document that you want
to print.

 

6. Press the OK button to print the document.  
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7 Color

● Adjust color
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Adjust color
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job
1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital
mini lab. The product renders deeper, more saturated colors differently than with the Default
(sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.

Change the color options
Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.
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3. Click the Color tab.

4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. You can also use this option to
print draft copies or to save color toner.

6. Click the OK button.

Manual color options
Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for
text, graphics, and photographs.

Table 7-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.
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Table 7-1  Manual color options (continued)

Setting description Setting options

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.
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8 Manage and maintain

● Print information pages

● Use the HP Embedded Web Server

● Use HP Web Jetadmin software

● Clean the product

● Product updates
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Print information pages
Information pages provide details about the product and its current configuration. Use the following
procedures to print commonly used information pages:

1. At the control panel, press the Home  button.

2. Open the following menus:

Administration

Reports

Configuration/Status Pages or Other Pages

3. Use the down arrow button  to highlight the a report, and then press the OK button to select it.

4. Use the up arrow button  to highlight the Print item, and then press the OK button.

Table 8-1  Reports menu

First level Second level Description

Configuration/Status Pages Menu Map Prints a map of the control panel-menu
layout. The active settings for each menu are
listed.

 Configuration Pages Shows the product settings and installed
accessories.

 Supplies Status Shows the approximate remaining life for the
supplies; reports statistics on total number of
pages and jobs processed, serial number,
page counts, and maintenance information.

HP provides approximations of the
remaining life for the supplies as a customer
convenience. The actual remaining supply
levels might be different than the
approximations provided.

 Usage Page Shows a count of all paper sizes that have
passed through the product; lists whether
they were simplex, duplex, monochrome, or
color; and reports the page count.

 Paper Path Page Shows how many pages were printed from
each tray.

 File Directory Page Shows the file name and folder name for files
that are stored in the product memory.

 Current Settings Page Shows the current settings of the product.

 Color Usage Prints the color-use statistics for the product.

Other Pages Demo Page Prints a demonstration page that highlights
the printing capability of the product.
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Table 8-1  Reports menu (continued)

First level Second level Description

 Print RGB Samples Prints color samples for different RGB values.
Use the samples as a guide for matching
printed colors.

 CMYK Samples Prints color samples for different CMYK
values. Use the samples as a guide for
matching printed colors.

 PCL Font List Prints a list of all the PCL fonts that are
installed.

 PS Font List Prints a list of all the PostScript (PS) fonts that
are installed.
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Use the HP Embedded Web Server
Use the HP Embedded Web Server to view product status, configure product network settings, and to
manage printing functions from your computer instead of from the product control panel. The following
are examples of what you can do using the HP Embedded Web Server:

● View product status information.

● Determine the remaining life for all supplies and order new ones.

● View and change tray configurations.

● View and change the product control-panel menu configuration.

● View and print internal pages.

● Receive notification of product and supplies events.

● View and change network configuration.

To use the HP Embedded Web Server, your browser must meet the following requirements:

● Windows: Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later

● Mac OS X: Safari or Firefox using Bonjour or an IP address

● Linux: Netscape Navigator only

● HP-UX 10 and HP-UX 11: Netscape Navigator 4.7

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP
Embedded Web Server does not support IPX-based product connections. You do not have to have
Internet access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically
available.

NOTE: For complete information about using the HP Embedded Web Server, see the HP Embedded
Web Server User Guide, which is on the HP website at www.hp.com/support/lj500colorM551.

Open the HP Embedded Web Server by using a network
connection

1. Identify the product IP address or host name.

Open the following menus:

1. Administration

2. Reports

3. Configuration/Status Pages

2. Use the down arrow button  to highlight the Configuration Pages item, and then press the
OK button.
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3. Use the up arrow button  to highlight the Print item, and then press the OK button.

4. Locate the IP address or host name on the HP Jetdirect page.

NOTE: Mac OS X users can also reference the Bonjour (mDNS) name located on the
configuration page to access the Embedded Web Server from the Safari browser.

5. In a supported Web browser on your computer, type the product IP address or host name in the
address/URL field.

Features

Information tab

Table 8-2  HP Embedded Web Server Information tab

Menu Description

Device Status Shows the product status and shows the estimated life remaining of HP supplies. The
page also shows the type and size of paper set for each tray. To change the default
settings, click the Change Settings link.

Configuration Page Shows the information found on the configuration page.

Supplies Status Shows a detailed status of the installed HP supplies.

Event Log Page Shows a list of all product events and errors. Use the HP Instant Support link (in
the Other Links area on all HP Embedded Web Server pages) to connect to a set
of dynamic Web pages that help you solve problems. These pages also show
additional services available for the product.

Usage Page Shows a summary of the number of pages the product has printed, grouped by
size, type, and paper print path.

Device Information Shows the product network name, address, and model information. To customize
these entries, click the Device Information menu on the General tab.

Print Allows uploading a file from your hard disk or network file server to be printed. The
following file types are supported:

● .txt

● .ps

● .pdf

● .pcl

● .cht

● .prn

Print Reports and Pages Lists the internal reports and pages for the product. Select one or more items to print
or view.
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General tab

Table 8-3  HP Embedded Web Server General tab

Menu Description

Control Panel Administration
Menu

Provides a remote view of the Administration menu available at the control panel
of the product.

Alert Subscriptions Set up e-mail alerts for various product and supplies events.

AutoSend Configure the product to send automated e-mails regarding product configuration
and supplies to specific e-mail addresses.

Control Panel Snapshot Provides an inactive view of the control panel of the product.

Sleep Schedule Set or edit a wake time, sleep time, and sleep delay for the product. You can set a
different schedule for each day of the week and for holidays.

Edit Other Links Add or customize a link to another website. This link appears in the Other Links
area on all HP Embedded Web Server pages.

Device Information Name the product and assign an asset number to it. Enter the name of the primary
contact who will receive information about the product.

Language Set the language in which to display the HP Embedded Web Server information.

Date and Time Set the date and time or synchronize with a network time server.

Backup and Restore Create a backup file that contains product and user data. If necessary, you can use
this file to restore data to the product.

Solution Installer Install third-party software programs that can enhance the product functionality.

Firmware upgrade Download and install product firmware upgrade files.

Print tab

Use the Print tab to enable or disable walk-up USB printing. Jobs printed from USB will use the default
print settings. the following file types are supported for walk-up USB printing:

● .pdf

● .prn

● .pcl

● .ps

● .cht

Table 8-4  HP Embedded Web Server Print tab

Menu Description

Retrieve Job From USB Use this item to enable or disable this feature.

Manage Stored Jobs Use this feature to manage jobs stored on the product memory.
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Table 8-4  HP Embedded Web Server Print tab (continued)

Menu Description

Restrict Color Use this item to restrict the number of color pages that can be printed from this product.

General Print Settings Use this item to manage the print settings for this product.

Troubleshooting tab

Table 8-5  HP Embedded Web Server Troubleshooting tab

Menu Description

Reports and Tests Print or view product settings, information pages, and diagnostic test pages.

Calibration/Cleaning Provides remote control of the cleaning and calibration operations of the product.

Firmware upgrade Download and install product firmware upgrade files.

Security tab

Table 8-6  HP Embedded Web Server Security tab

Menu Description

General Security Configure an administrator password so you can restrict access to certain features
on the product.

Enable or disable the Host USB port on the control panel or the USB connectivity
port on the formatter for printing directly from a computer.

Access Control Configure access to product functions for specific individuals or groups. Also select
the method by which individuals sign in to the product.

Protect Stored Data Configure and manage the internal hard drive for the product. This product includes
an encrypted hard drive for maximum security.

Configure settings for jobs that are stored on the product hard drive.

Certificate Management Install and manage security certificates for access to the product and the network.

Networking tab

Use the Networking tab to change network settings for the product when it is connected to an IP-
based network. This tab does not appear if the product is connected to other types of networks.

Other Links list

NOTE: You can configure which items appear in the Other Links list by using the Edit Other
Links menu on the General tab. The following items are the default links.
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Table 8-7  HP Embedded Web Server Other Links list

Menu Description

HP Instant Support Connects you to the HP website to help you find solutions to product problems.

Shop for Supplies Connects you to the HP website for ordering supplies.

Product Support Connects to the support site for the product, from which you can search for help
regarding various topics.

Show Me How Connects you to the HP website for product support.
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Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. Management is proactive, allowing network
administrators the ability to resolve issues before users are affected. Download this free, enhanced-
management software at www.hp.com/go/webjetadmin. 

Device plug-ins can be installed into HP Web Jetadmin to provide support for specific product features.
The HP Web Jetadmin software can automatically notify you when new plug-ins are available. On the
Product Update page, follow the directions to automatically connect to the HP Web site and install
the latest device plug-ins for your product.

NOTE: HP Web Jetadmin is not supported from Mac OS X.
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Clean the product
Over time, particles of toner and paper accumulate inside the product. This can cause print-quality
problems during printing. Cleaning the product eliminates or reduces these problems.

Clean the paper path and print-cartridge areas every time that you change the print cartridge or
whenever print-quality problems occur. As much as possible, keep the product free from dust and
debris.

To clean the product exterior, use a soft, water-moistened cloth.

Clean the paper path
1. At the product control panel, press the Home  button.

2. Open the following menus:

1. Device Maintenance

2. Calibration/Cleaning

3. Press the down arrow  to highlight the Print Cleaning Page menu item, and then press the
OK button.

4. Completion of the cleaning process depends on the product model:

● Non-duplex models: After the first side prints, reload the page into Tray 1 according the
instructions, and then press the OK button. After the second side prints, the task is complete.
Discard the printed page.

● Duplex models: After both sides print, the task is complete. Discard the printed page.

Product updates
Software and firmware updates and installation instructions for this product are available at
www.hp.com/support/lj500colorM551. Click Downloads and drivers, click the operating system,
and then select the download for the product.
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9 Solve problems

● Self help

● Solve problems checklist

● Interpret control-panel messages

● Paper feeds incorrectly or becomes jammed
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

Printable poster for using the product
control panel

This poster is available on the product CD. It prints on four full-color pages that you
can post near the product. It contains information on using the buttons and other
features available on the product control panel.

Quick Reference Topics Several Quick Reference Topics for this product are available at this website:
www.hp.com/support/lj500colorM551.

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams.
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

1. Make sure the product Ready light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power is turned on.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip
and its voltage is not within specifications, plug the product directly into the wall. If it is
already plugged into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer or network port. Make
sure that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection.

3. The control panel should indicate ready status. If an error message appears, resolve the error.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page. If the product is connected to a network, an HP Jetdirect page also
prints.

a. At the product control panel, press the Home  button.

b. Open the following menus:

◦ Administration

◦ Reports

◦ Configuration/Status Pages

◦ Configuration Pages

c. Press the OK button.

If the pages do not print, check that at least one tray contains paper.

If the page jams in the product, follow the instructions on the control panel to clear the jam.

ENWW Solve problems checklist 127



6. If the configuration page prints, check the following items:

a. If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

b. If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

7. Select one of the following options:

Windows: Click Start, click Settings, and then click Printers or Printers and Faxes.
Double-click the name of the product.

-or-

Mac OS X: Open the Printer Setup Utility or the Print & Fax list, and double-click the line
for the product.

8. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product. The printer driver is on the CD that came with
the product. You can also download the printer driver from this Web site: www.hp.com/support/
lj500colorM551.

9. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. If you connected the product to the network, connect the product directly to a computer with
a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the
new connection type that you are using.

Factors that affect product performance
Several factors affect the time it takes to print a job:

● Maximum product speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The product I/O configuration

● The network operating system and configuration (if applicable)

● The printer driver that you are using
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Interpret control-panel messages
Control-panel message types

Four types of control-panel messages can indicate the status of or problems with the product.

Message type Description

Status messages Status messages reflect the current state of the product. They inform you of normal product operation
and require no interaction to clear them. They change as the state of the product changes. Whenever
the product is ready, not busy, and has no pending warning messages, the Ready status message
appears if the product is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you press the OK button. Some warning messages are
clearable. If the Clearable Warnings menu in the Display Settings menu is set to the Job
option, the next print job clears these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.

Some error messages are auto-continuable. If the Continuable Events menu in the Display
Settings menu is set to the Auto continue (10 seconds) option, the product continues normal
operation after an auto-continuable error message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop 
button pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a product failure. You can clear some of these messages by
turning the product off and then on. These messages are not affected by the Auto continue (10
seconds) setting. If a critical error persists, service is required.

Control-panel messages
The product provides robust control panel messaging. When a message appears on the control panel,
follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention”
message, and no steps are shown to resolve the issue, turn the product off then on. Contact HP support
if you continue to experience issues with the product.

For additional information on a variety of topics, press the Help button  on the control panel.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

● Clear jams

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.
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5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.

Clear jams

Jam locations

Use this illustration to identify locations of jams. In addition, instructions appear on the control panel to
direct you to the location of jammed paper and how to clear it.

NOTE: Internal areas of the product that might need to be opened to clear jams have green handles
or green labels.

Figure 9-1  Jam locations

1 2

3

4

5

6

1 Output-bin area

2 Duplexing area

3 Tray 1 area

4 Optional 500-sheet paper and heavy media tray (Tray 3)

5 Tray 2 pickup area

6 Fuser area
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Clear jams in the right door

CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before clearing
jams.

1. Open the right door.  

2. If paper is jammed as it enters the output bin,
gently pull the paper downward to remove it.

 

3. If paper is jammed inside the right door, gently
pull the paper to remove it.
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4. Lift the paper-feed cover on the inside of the
right door. If jammed paper is present, gently
pull the paper straight out to remove it.

 

1

2

5. Close the paper-feed cover.  

6. Gently pull the paper out of the pickup area.  

7. Look for paper in the Tray 2 roller area. Near
the bottom of the right side, squeeze the two
green levers upward to release the jam-access
door. Remove any jammed paper, and close
the door.
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8. If paper is visible entering the bottom of the
fuser, gently pull downward to remove it.

CAUTION: Do not touch the rollers on the
transfer roller. Contaminates can affect print
quality.

 

9. Paper could be jammed inside the fuser where
it would not be visible. Grasp the fuser
handles, lift up slightly, and pull straight out to
remove the fuser.

CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before clearing jams.

 

10. Open the jam-access door (callout 1). If paper
is jammed inside the fuser, gently pull it
straight up to remove it (callout 2). If the paper
tears, remove all paper fragments.

CAUTION: Even if the body of the fuser has
cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they
have cooled.

 

1

2
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11. Close the jam-access door, and push the fuser
completely into the product.

 

12. Close the right door.  
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Clear jams in the output bin area

1. If paper is visible from the output bin, grasp
the leading edge and remove it.

 

2. If jammed paper is visible in the duplex output
area, gently pull it to remove it.

 

136 Chapter 9   Solve problems ENWW



Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the
jam by gently pulling the paper straight out.
Touch the OK button to clear the message.

 

2. If you cannot remove the paper, or if no
jammed paper is visible in Tray 1, close Tray
1 and open the right door.

 

3. If paper is visible inside the right door, gently
pull the trailing edge to remove it.
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4. Gently pull the paper out of the pick up area.  

5. Close the right door.  
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Clear jams in Tray 2

CAUTION: Opening a tray when paper is jammed can cause the paper to tear and leave pieces of
paper in the tray, which might cause another jam. Be sure to clear jams before opening the tray.

1. Open Tray 2 and make sure that the paper is
stacked correctly. Remove any jammed or
damaged sheets of paper.

 

2. Close the tray.  
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Clear jams in the optional 500-sheet paper and heavy media tray (Tray 3)

1. Open Tray 3 and make sure that the paper is
stacked correctly. Remove any damaged or
jammed sheets of paper.

 

2. Close Tray 3.  
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Clear jams in the lower right door (Tray 3)

1. Open the lower right door.  

2. If paper is visible, gently pull the jammed
paper up or down to remove it.

 

3. Close the lower right door.  
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Change jam recovery

This product provides jam recovery, a feature that you can use to reprint jammed pages. The following
options are available:

● Auto — The product attempts to reprint jammed pages when sufficient memory is available.

● Off — The product does not attempt to reprint jammed pages. Because no memory is used to
store the most recent pages, performance is optimal.

NOTE: When using this option, if the product runs out of paper and the job is being printed on
both sides, some pages can be lost.

● On — The product always reprints jammed pages. Additional memory is allocated to store the
last few pages printed. This might cause overall performance to suffer.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● General Settings

● Jam Recovery

3. Select the appropriate setting, and then press the OK button.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers

ENWW 143



Order parts, accessories, and supplies
Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using HP software Use the HP Embedded Web Server on page 118
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Part numbers
Ordering information and availability might change during the life of the product.

Accessories

Item Description Part number

HP Color LaserJet  1 x 500 Paper
Feeder

500-sheet paper and heavy media tray. CF084A

Print cartridges and toner collection unit

Item Description1 Cartridge number Part number

HP Color LaserJet black print
cartridge

Standard black cartridge 507A CE400A

HP Color LaserJet black print
cartridge

High-capacity black cartridge 507X CE400X

HP Color LaserJet cyan print
cartridge

Cyan cartridge 507A CE401A

HP Color LaserJet yellow print
cartridge

Yellow cartridge 507A CE402A

HP Color LaserJet magenta
print cartridge

Magenta cartridge 507A CE403A

Toner Collection Unit Receptacle for toner that has
not fused to the paper.

 CE254A

1 For more information, go to www.hp.com/go/learnaboutsupplies

Cables and interfaces

Item Description Part number

HP Jetdirect print servers HP Jetdirect ew2500 Wireless Print
Server

J8021A

 HP Jetdirect 2700w USB Wireless Print
Server

J8026A

USB cable 2-meter standard USB-compatible device
connector

C6518A
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Maintenance kits

Item Description Part number

Fuser kit 110 Volt replacement fuser CE484A

220 Volt replacement fuser CE506A
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B Service and support

● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● Color LaserJet Fuser Kit, Toner Collection Unit, and Transfer Kit Limited Warranty Statement

● Data stored on the print cartridge

● End User License Agreement

● OpenSSL

● Customer self-repair warranty service

● Customer support
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Hewlett-Packard limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Enterprise 500 color CF081A, CF082A, CF083A One-year on-site warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace
products which prove to be defective. Replacement products may be either new or equivalent in
performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you
will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some
countries/regions, states or provinces do not allow limitations on the duration of an implied warranty,
so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights
and you might also have other rights that vary from country/region to country/region, state to state, or
province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE
YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR
ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL,
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED
IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the
exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may
not apply to you.
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THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Color LaserJet Fuser Kit, Toner Collection Unit, and
Transfer Kit Limited Warranty Statement

This HP product is warranted to be free from defects in materials and workmanship until the printer
provides a low-life indicator on the control panel.

This warranty does not apply to products that (a) have been refurbished, remanufactured or tampered
with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside
of the published environmental specifications for the printer product or (c) exhibit wear from ordinary
use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem) or contact HP customer support. At HP’s option, HP will either replace products that prove
to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Data stored on the print cartridge
The HP print cartridges used with this product contain a memory chip that assists in the operation of the
product.

In addition, this memory chip collects a limited set of information about the usage of the product, which
might include the following: the date when the print cartridge was first installed, the date when the print
cartridge was last used, the number of pages printed using the print cartridge, the page coverage, the
printing modes used, any printing errors that might have occurred, and the product model. This
information helps HP design future products to meet our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used
to identify a customer or user of the print cartridge or their product.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and
recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this
print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the memory chip cannot be used in an HP
product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL
TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT
ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF
YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE
SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE
PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHER
HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software (“HP
Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is in a file such as
“license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party
License. If the Third Party Licenses include licenses that provide for the availability of source code
(such as the GNU General Public License) and the corresponding source code is not included with
the Software, then check the product support pages of HP's website (hp.com) to learn how to
obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You
may not modify the HP Software or disable any licensing or control feature of the
HP Software. If this Software is provided by HP for Use with an imaging or printing product
(for example, if the Software is a printer driver, firmware, or add-on), the HP Software may
only be used with such product (“HP Product”). Additional restrictions on Use may appear in
the User Documentation. You may not separate component parts of the HP Software for Use.
You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may
no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other
terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other
terms will prevail.
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4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of
the HP Software to another end user. Any transfer will include all component parts, media,
User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer
may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user
receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software,
your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer
the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright
notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s
privacy policy. HP will not use such information in a form that personally identifies you except to
the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited
to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL
PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental
or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
Software is commercial computer software within the meaning of the applicable acquisition
regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
subcontractor is subject solely to the terms and conditions set forth in this End User License
Agreement, except for provisions which are contrary to applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you in
this EULA.
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© 2009 Hewlett-Packard Development Company, L.P.

Rev. 04/09
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OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).
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Customer self-repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period,
HP identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part
directly to you for replacement. There are two categories of CSR parts: 1) Parts for which customer self
repair is mandatory. If you request HP to replace these parts, you will be charged for the travel and
labor costs of this service. 2) Parts for which customer self repair is optional. These parts are also
designed for Customer Self Repair. If, however, you require that HP replace them for you, this may be
done at no additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether a
defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support
Get telephone support for your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/lj500colorM551

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/go/lj500colorM551_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table C-1  Product dimensions

Product Height Depth Width Weight

HP LaserJet Enterprise 500 color
M551n

389 mm (15.3 in) 489 mm (19.3 in) 514 mm (20.2 in) 36.5 kg (80.5 lb)

HP LaserJet Enterprise 500 color
M551dn

408 mm (16.1 in) 489 mm (19.3 in) 514 mm (20.2 in) 37 kg (81.6 lb)

HP LaserJet Enterprise 500 color
M551xh

575 mm (22.6 in) 489 mm (19.3 in) 514 mm (20.2 in) 44.6 kg (98.3 lb)

Table C-2  Product dimensions, with all doors and trays fully opened

Product Height Depth Width

HP LaserJet Enterprise 500 color M551n 389 mm (15.3 in) 804 mm (31.7 in) 824 mm (32.4 in)

HP LaserJet Enterprise 500 color M551dn 408 mm (16.1 in) 804 mm (31.7 in) 824 mm (32.4 in)

HP LaserJet Enterprise 500 color M551xh 575 mm (22.6 in) 804 mm (31.7 in) 824 mm (32.4 in)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/lj500colorM551_regulatory for current information.

Environmental specifications
Environmental condition Recommended Allowed

Temperature (product and print
cartridge)

17° to 25°C (63° to 77°F) 15° to 27°C (59° to 81°F)

Relative humidity 30% to 70% relative humidity (RH) 10% to 70% RH

Altitude N/A 0 m (0 ft) to 3000 m (9842 ft)
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of conformity

● Safety statements
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy, and if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class A limits of Part 15 of FCC rules.
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Environmental product stewardship program
Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready or Sleep or Auto-off mode, which saves natural
resources and saves money without affecting the high performance of this product. Hewlett-Packard
printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S.
Environmental Protection Agency's ENERGY STAR specifications for imaging equipment. The following
mark will appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Paper use
This product’s manual/automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
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properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-addressed
shipping label contained in the box. To use the UPS label, give the package to the UPS driver during
your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS Ground
pickup will be charged normal pick-up rates) For the location of your local UPS drop-off center, call
1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal Service
carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground pickup will be
charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at any U.S. Post
Office or any FedEx shipping center or store. For the location of your nearest U.S. Post Office, please
call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx shipping center/
store, please call 1-800-GOFEDEX or visit www.fedex.com.
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For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP LaserJet Enterprise 500 color M551

Type Carbon monofluoride lithium

Weight 0.8 g

Location On formatter board

User-removable No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.
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Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop
where you purchased the product.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be
found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0802-03-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Enterprise 500 color M551 series

Regulatory Model Number2) BOISB-0802-03

Including:

 CF084A 500-sheet Paper/Heavy Media Tray

Product Options: ALL

Print Cartridges: CE400A, CE400X, CE401A, CE402A, CE403A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006+A11

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class A1), 3)

EN 61000-3-2:2006

EN 61000-3-3:2008

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class A1), 3) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC,

and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a
class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take
adequate measures.”

3. 3) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).
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Boise, Idaho USA

September 2011

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.eu/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements
Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class A requirements.

« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions
Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (China)

EMC statement (Korea)

EMI statement (Taiwan)

Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet Enterprise 500 color M551n, M551dn, M551xh, laserkirjoitin on käyttäjän kannalta
turvallinen luokan 1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen
pääsyn laitteen ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007)
mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet Enterprise 500 color M551n, M551dn, M551xh - kirjoittimen sisällä ei ole käyttäjän
huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu
henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta
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tai muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan
suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W
Luokan 3B laser.

GS statement (Germany)
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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500-sheet paper and heavy media

tray
models including 2

A
accessories

ordering 144
part numbers 145

acoustic specifications 160
Administration menu, control

panel 13
anticounterfeit supplies 70
Attention light

locating 5
automatic overhead transparency

sensing 62

B
Backup/Restore menu, control

panel 30
batteries included 165
bins, output

capacity 59
Bonjour

identifying 118
booklets

creating (Windows) 106
browser requirements

HP embedded Web Server
118

buttons, control panel
locating 5

C
cable, USB

part number 145
Calibrate/Cleaning menu, control

panel 30
Canadian DOC regulations 169

canceling print jobs 78
cartridges

non-HP 69
recycling 69, 163
storage 69
warranty 150

cartridges, print
part numbers 145
replacing 71

cautions iii
cleaning

product 124
color

adjusting 112
Edge Control 113
halftone options 114
manage 111
Neutral Grays 114
printing in grayscale

(Windows) 95
using 111

color options
setting (Windows) 94

configurations, models 2
configuring

IP address 36
control panel

Administration menu 13
Backup/Restore menu 30
buttons 5
Calibrate/Cleaning menu 30
cleaning page, printing 124
Display Settings menu 21
General Settings menu 13
help 6
lights 5
Manage Supplies menu 22
Manage Trays menu 23
messages, types of 129

Network Settings menu 24
Print Options menu 19
Print Settings menu 18
Reports menu 13
Service menu 31
Supplies menu 10
Trays menu 12
Troubleshooting menu 28
USB Firmware Upgrade menu

31
control-panel menus

Retrieve From USB Settings 18
retrieve job from device

memory 9
Retrieve Job From USB 8
Sign In 8

controlling print jobs 62
conventions, document iii
copies

changing number of
(Windows) 80

counterfeit supplies 70
cover pages

printing on different paper
(Windows) 101

custom print settings (Windows)
80

customer support
online 158

D
Data light

locating 5
default gateway, setting 39
Display Settings menu, control

panel 21
disposal, end-of-life 165
document conventions iii
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drivers
changing paper types and

sizes 46
paper types 50
settings (Windows) 79

duplex printing (double-sided)
settings (Windows) 87

duplex settings, changing 41

E
Edge Control 113
electrical specifications 160
Embedded Web Server (EWS)

features 118
network connection 118

end-of-life disposal 165
envelopes

loading in Tray 1 52
environment, specifications 160
Environmental Product Stewardship

Program 163
error messages

control panel 129
types of 129

European Union, waste disposal
166

Explorer, versions supported
HP Embedded Web Server

118

F
FCC regulations 162
features 2
Finnish laser safety statement 170
first page

printing on different paper
(Windows) 101

forms
printing (Windows) 96

fraud hotline 70
fuser

jams 132

G
gateway, setting default 39
general configuration

HP Embedded Web Server
120

General Settings menu, control
panel 13

graphical and text display, control
panel 5

grayscale
printing (Windows) 95

H
help

printing options (Windows) 80
help, control panel 6
HP Customer Care 158
HP Embedded Web Server

general configuration 120
information pages 119
network settings 121
other links list 121
print tab 120
security settings 121
troubleshooting tools 121

HP Embedded Web Server (EWS)
features 118
network connection 118

HP fraud hotline 70
HP Jetdirect print server

models including 2
HP Web Jetadmin 123
humidity requirements 160

I
information pages

HP Embedded Web Server
119

printing or viewing 116
installing

print cartridges 71
product on wired networks 36
software, wired networks 37

Internet Explorer, versions
supported

HP Embedded Web Server
118

IP address
configuring 36

IPv4 address 39
IPv6 address 40

J
jams

causes of 130
fuser 132
lower right door 141
output bin 136

recovery 142
right door 132
Tray 1 137
Tray 2 139
Tray 3 140, 141

Japanese VCCI statement 169
Jetadmin, HP Web 123
Jetdirect print server

models including 2
part number 145

K
keys, control panel

locating 5
Korean EMC statement 170

L
labels

printing (Windows) 98
landscape orientation

selecting, Windows 92
laser safety statements 169, 170
last page

printing on different paper
(Windows) 101

letterhead
printing (Windows) 96

license, software 153
lights

control panel 5
link speed settings 41
loading

Tray 1 52
Tray 2 54

loading paper 52
lower right door

jams 141

M
Macintosh

support 158
Manage Supplies menu, control

panel 22
Manage Trays menu, control

panel 23
managing network 38
material restrictions 165
Material Safety Data Sheet

(MSDS) 166
media

supported sizes 47
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memory
included 2

memory chip, print cartridge
description 152

Menu button 5
menus, control panel

Administration 13
Backup/Restore 30
Calibrate/Cleaning 30
Display Settings 21
General Settings 13
Manage Supplies 22
Manage Trays 23
Network Settings 24
Print Options 19
Print Settings 18
Reports 13
Service 31
Supplies 10
Trays 12
Troubleshooting 28
USB Firmware Upgrade 31

menus, control-panel
Retrieve From USB Settings 18
retrieve job from device

memory 9
Retrieve Job From USB 8
Sign In 8

mercury-free product 165
messages

types of 129
models, features 2
multiple pages per sheet

printing (Windows) 90

N
n-up printing

selecting (Windows) 90
Netscape Navigator, versions

supported
HP embedded Web Server

118
network

password, changing 38
password, setting 38
settings, changing 38
settings, viewing 38

network settings
HP Embedded Web Server

121

Network Settings menu, control
panel 24

networks
configuring 34
default gateway 39
HP Web Jetadmin 123
IPv4 address 39
IPv6 address 40
print servers included 2
protocols supported 34
security 35
subnet mask 39

networks, wired
installing product 36

Neutral Grays 114
non-HP supplies 69
notes iii

O
online help, control panel 6
online support 158
opening printer drivers

(Windows) 79
operating environment

specifications 160
ordering

part numbers for 145
supplies and accessories 144

orientation
selecting, Windows 92

other links list
HP Embedded Web Server

121
output bin

jams 136

P
page sizes

scaling documents to fit
(Windows) 103

pages per sheet
selecting (Windows) 90

paper
covers, using different paper

101
first and last pages, using

different paper 101
jams 130
load 52
loading Tray 3 57

printing on preprinted letterhead
or forms (Windows) 96

supported sizes 47
supported types 50

paper path
cleaning 124

paper pickup problems
solving 130

paper size
changing 46

paper sizes
selecting 85
selecting custom 85

paper types
changing 46
selecting 85

paper, ordering 144
paper, special

printing (Windows) 98
part numbers

print cartridges 145
portrait orientation

selecting, Windows 92
power

consumption 160
preprinted paper

printing (Windows) 96
print cartridges

memory chips 152
non-HP 69
part numbers 145
recycling 69, 163
replacing 71
storage 69
warranty 150

print media
loading in Tray 1 52

Print Options menu, control panel
19

print quality
improving (Windows) 85

print server
part number 145

Print Settings menu, control panel
18

print tab
HP Embedded Web Server

120
print tasks 77
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printer drivers (Windows)
settings 79

printing
canceling jobs 78
from USB storage accessories

108
settings (Windows) 79

printing from Tray 2 54
printing on both sides

settings (Windows) 87
problem-solving

messages, types of 129
product info 1
product specifications 159
protocols, network 34

R
Ready light

locating 5
recycling

HP printing supplies returns and
environmental program 164

recycling supplies 69
regulatory statements

environmental product
stewardship program 163

Reports menu, control panel 13
reset button 5
resize documents

Windows 103
resolution

selecting (Windows) 85
Retrieve From USB Settings menu

18
retrieve job from device memory

menu 9
Retrieve Job From USB menu 8
right door

jams 132

S
safety statements 169, 170
scale documents

Windows 103
secuity settings

HP Embedded Web Server
121

security features 35
self help

accessing 126

Service menu, control panel 31
shortcuts (Windows)

creating 82
using 80

Sign In menu 8
Sleep button 5
software

installing, wired networks 37
software license agreement

153
special media

guidelines 44
special paper

guidelines 44
printing (Windows) 98

specifications
electrical and acoustic 160
operating environment 160

Start button 5
status

messages, types of 129
Status button 5
Stop button 5
stopping print jobs 78
storing

print cartridges 69
subnet mask 39
supplies

counterfeit 70
non-HP 69
ordering 144
part numbers 145
recycling 69, 163

Supplies menu, control panel 10
support

online 158
supported media 47
system requirements

HP Embedded Web Server
118

T
Taiwan EMI statement 170
TCP/IP

manually configuring IPv4
parameters 39

manually configuring IPv6
parameters 40

technical support
online 158

temperature requirements 160
tips iii
toner cartridges. See print

cartridges
toner collection unit

replacing 73
transparencies

printing (Windows) 98
trapping 113
Tray 1

capacity 60
jams 137

Tray 2
jams 139

Tray 3
jams 140, 141

trays
automatic overhead

transparency sensing 62
capacity 59
configure 61
included 2
load 52
selecting (Windows) 85

Trays menu, control panel 12
troubleshooting

control panel messages 129
jams 130
paper feed problems 130

Troubleshooting menu, control
panel 28

troubleshooting tools
HP Embedded Web Server

121
two-sided printing

settings (Windows) 87

U
USB Firmware Upgrade menu,

control panel 31
USB storage accessories

printing from 108

W
walk-up USB printing 108
warnings iii
warranty

customer self repair 157
license 153
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print cartridges 150
product 148

watermarks
adding (Windows) 105

Web browser requirements
HP Embedded Web Server

118
Web sites

customer support 158
fraud reports 70
HP Web Jetadmin,

downloading 123
Macintosh customer support

158
Material Safety Data Sheet

(MSDS) 166
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